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ISTRUZIONI PER LA STESURA DEL LAVORO FINALE NEL PROGRAMMA ESTETISTA MEDICO

Il lavoro finale è l'elaborazione professionale ed autonoma di un tema prescelto da parte dello studente. Con la stesura e la difesa del lavoro finale lo studente:
 • dimostra il livello di acquisizione di conoscenze teoriche e pratiche e la capacità di consultare la letteratura professionale e le fonti elettroniche di dati 
• dimostra il grado delle competenze acquisite e dei risultati della formazione nel profilo istruttivo
• dimostra la competenza di ricerca indipendente e di elaborazione professionale, su temi selezionati in modo sistematico, logico e grammaticalmente e ortograficamente corretto. 
Con la difesa del lavoro finale sotto forma di presentazione lo studente dimostra la propria capacità di esposizione autonoma, di spiegazione e di presentazione dei risultati della ricerca nel lavoro scritto.
Lo studente sceglie l'argomento del lavoro finale, consultandosi con gli insegnanti delle materie professionali rispettando i termini del Regolamento di stesura e difesa del lavoro finale (NN 118/2009).
I termini della stesura e della difesa del lavoro finale prescritti dal Regolamento sono:

1. Il calendario della stesura e della difesa del lavoro finale viene approvato dal Comitato scolastico su proposta del preside della scuola entro il 7 ottobre per l’anno scolastico in corso, in conformità con il Piani e il programma della scuola. Il calendario comprende le scadenze per la scelta dei temi, per la stesura, per la consegna del lavoro finale e per la difesa del lavoro finale e viene pubblicato entro il 15 ottobre

2. La scuola entro il 15 ottobre dell’anno in corso ha l'obbligo di informare i maturanti sul contenuto, sulle condizioni, sulle modalità e sulla procedura della stesura e della difesa del lavoro finale.

3. I temi del lavoro finale, in collaborazione con i docenti delle materie professionali, vengono pubblicati dal preside dell’istituzione, entro il 15 ottobre per tutte le scadenze dell’anno scolastico in corso su proposta degli Attivi professionali. Il numero dei temi proposti deve essere il minimo del 50% superiore al numero degli studenti. 
Possono venir prese in considerazione anche le proposte degli alunni che sono in sintonia con gli obiettivi e gli esiti del programma d’insegnamento.
4. Gli studenti devono scegliere il tema del lavoro finale entro il 31 ottobre dell’anno in corso.

Il lavoro finale consiste nella stesura e nella difesa dello stesso davanti alla commissione preposta. 

Lo studente esegue la stesura del lavoro finale sotto la guida dell’insegnante mentore. 
Dopo aver scelto il tema del lavoro finale lo studente raccoglie il materiale bibliografico, libri di testo, articoli di riviste, informazioni da internet o da banche dati che trattano l'argomento scelto. Lo studio del materiale bibliografico è un presupposto necessario per un ulteriore lavoro individuale 

L'insegnante definisce con lo studente il contenuto preciso e la strutturazione del lavoro finale. Durante la preparazione del lavoro finale nell'orario previsto per le consultazioni accordate, l'insegnante è disponibile per tutti i chiarimenti, suggerimenti riguardanti la stesura del lavoro e consigli su ulteriori fonti bibliografiche.

Il mentore segue il lavoro degli studenti e li aiuta con dei consigli, e può richiedere la rielaborazione, un'aggiunta o la modifica del lavoro finale. Lo studente è tenuto ad agire secondo le istruzioni e le osservazioni del mentore.

INDICAZIONI TECNICHE SUL LAVORO FINALE
 Il lavoro finale si compone dalle seguenti parti:
- prima pagina 
- contenuto (indice)
- introduzione
- parte principale – elaborazione del tema 
- conclusione 
- bibliografia
- allegati
Modulo "Evidenza delle consultazioni"
Modulo "Valutazione del lavoro finale"

Indicazioni:
a) Nella prima pagina l'autore stabilisce il primo contatto con il lettore del lavoro. Essa deve contenere le informazioni principali (sulla scuola, l'indirizzo, lo studente, il mentore, la materia d'insegnamento, il titolo del lavoro finale, anno scolastico) e deve essere adeguatamente progettata. Non si segna mai con il numero progressivo. Non è permesso inserire le fotografie sulla prima pagina. (Allegato 1)
b) L'indice (contenuto) rappresenta una presentazione tematica del lavoro e la programmazione delle pagine del lavoro nelle quali si trovano i titoli delle parti, dei capitoli, delle sezioni. I contenuti vengono posizionati subito dopo la prima pagina. (Allegato 2) 
c) L'introduzione si numera con il numero arabo 1. L'introduzione contiene le principali indicazioni dei problemi che verranno successivamente presi in esame (si nomina il problema e la ragione della scelta della materia presa in esame), il metodo di elaborazione dei problemi e la struttura del lavoro. 
d) La parte principale o l'elaborazione del tema, se il tema lo permette, si compone di due parti fondamentali. La prima parte è la parte teorica nella quale vengono esposti i contributi teorici di diversi autori. La seconda parte è la parte pratica, dove si presenta un esempio concreto del problema o un caso pratico. L'intero contenuto del testo del lavoro deve essere elaborato con un nesso logico.
· Es. La cellulite: patologia del tessuto connettivo – spiegare l’aspetto, i trattamenti con i vari macchinari o prodotti, l’autocura ed il trattamento pratico.
· Es. Trucco – spiegare la storia, l’evoluzione, le tendenze e la parte pratica del trucco.
· Es. Pedicure – spiegare l’anomalia del piede, procedimento del lavoro, inestetismi, patologie e il trattamento pratico.
e) Il testo del lavoro finale termina con la conclusione, nella quale si presentano in breve i risultati e le conoscenze alle quali si è giunti grazie al lavoro. Inoltre, nella conclusione, è auspicabile esprimere la propria posizione sulla questione presa in esame, presentare eventuali incompatibilità per mostrare la differenza possibile tra teoria e pratica, ed esporre le proprie opinioni e suggerimenti. La conclusione deve iniziare su una pagina separata che deve essere numerata. 
f) La bibliografia segue la conclusione, prima di eventuali allegati o aggiunte. Il titolo Bibliografia si numera e si scrive in stampatello in cima alla pagina.
Le fonti si elencano in ordine alfabetico per cognome dell'autore e si indicano con i numeri arabi. Per prima cosa si scrive il cognome dell'autore, che si separa con una virgola dalle iniziali del nome. Poi si scrive il titolo del libro, il nome della casa editrice, la sede della casa editrice o il luogo in cui il libro è stato pubblicato e l'anno quando è stato pubblicato. 
Gli articoli utilizzati nel documento si elencano come segue: prima il nome dell'autore, poi il titolo dell'articolo e la rivista in cui l'articolo è stato pubblicato, il numero della rivista, l'anno di pubblicazione del numero specificato, e le pagine in cui l'articolo è stato stampato.

Esempi della bibliografia:
Libri, libri di testo
1. Jorgensen HS, Nakayama H, Raaschou HO, Olsen TS. (1995), Recovery of walking function in stroke patients: The Copenhagen Stroke Study. Arch Phys Med Rehabil; 76:27-32          
Articoli professionali:
1. Caiola S., Antonella P.: Cosmetici e genere: dalla tradizione al mercato globale; Rapporti ISTISAN 19/24, Cosmetici e salute, 2019, pp. 7-12.
2. Naletto C., Pellicini R.: Sclerosi multipla; efficacia del metodo Wim Hof, Fisioterapista, 2019. settembre-ottobre (1), pp. 69-74.
Pagine web:
1. http://www.sapere.it/sapere/medicina-e-salute/enciclopedia-medica/Cervello-e-sistema-nervoso-(neurologia)/amiotrofia.html (15.01.2015; 9:33)  
Nella stesura del lavoro finale si usa la rete Internet e perciò è importante sottolineare che il metodo di copia-incolla da Internet in Word non è considerato come preparazione del lavoro finale. I dati possono essere scaricati da Internet, ma non deve essere un copia-incolla di intere pagine. 
g) Gli allegati (documenti, ecc), si pongono alla fine del lavoro. Si numerano in cima alla pagina (Allegato n. 1, Allegato n. 2 ...) e si scrivono allo stesso modo nel contenuto.
Il mentore compila per ogni studente un modulo di consultazione nel quale annota quando e quante volte lo studente è venuto alle consultazioni. Il modulo di consultazione rimane dal mentore e non è parte del lavoro finale. (allegato 3) 
L'ultima pagina del lavoro finale deve figurare come l'allegato n. 4. Si deve lasciare lo spazio dove si inserirà la data di consegna del lavoro, il voto della preparazione del lavoro, la firma del mentore come prova che lo stesso abbia accettato il lavoro, la data della difesa del lavoro ed il voto finale che si calcola in base dalla media aritmetica dei voti della stesura e della difesa del lavoro. È possibile annotare il commento del mentore o della commissione per la difesa. 
Il numero di pagine del lavoro finale – da 10 a 15 pagine. (Un minimo di 10 pagine senza foto e con le foto si può arrivare a 15 pagine.) La prima pagina e gli allegati non si contano.
Due copie del lavoro rilegate a spirale (con la firma dal mentore sull'ultima pagina come conferma della sua accettazione del lavoro) devono essere consegnate in segreteria della scuola per certificarla e protocollarla.


DIFESA DEL LAVORO FINALE:
Il lavoro finale si difende davanti a tre membri della Commissione, composta dal mentore e da altri due professori di materie professionali. 
La difesa del lavoro dura al massimo 30 minuti.
Lo studente è tenuto a presentare in modo autonomo le tesi fondamentali del suo lavoro, per dimostrare la padronanza del tema trattato e rispondere alle domande dell'esaminatore.
La presentazione autonoma del tema del lavoro viene effettuata con l'ausilio di una presentazione in PowerPoint, che comprende 10 o più slide e con la presentazione della parte pratica con o senza un/a modello/a.
Se possibile, nella presentazione PowerPoint inserire tante foto e video dei trattamenti. Non scrivere tanto testo, ma solo brevi appunti con parole chiavi.
Se gli studenti hanno una versione più recente di Microsoft Office, svolgano la presentazione nella versione 97-2003: 
Save as–Save asType: PowerPoint 97-2003.
· dopo la presentazione lo studente risponde alle domande della Commissione.
· il voto viene comunicato allo studente dopo esser stato confermato dal Comitato di valutazione.
Una pagina di testo deve contenere 1800 caratteri per pagina, cioè una cartella. Come calcolare una cartella di testo? Tools ---Word count ---Caracters with blank spaces.
Il numero ottenuto si divide per 1800 e si ottiene così il numero esatto delle cartelle (che deve essere uguale al numero di pagine scritte).
Prima di scrivere il lavoro finale bisognerebbe ricordarsi che
- le parole si separano solo con uno spazio, 
- i segni di interpunzione devono essere scritti assieme alla parola che li precede e seguiti obbligatoriamente da uno spazio,
- le virgolette e le parentesi si scrivono assieme alla parola scritta, davanti e dietro, 
- il trattino si scrive assieme alle parole tra le quali si trova se si tratta di una parola composta (ad esempio, matematico-informatica), e separatamente, se utilizzato per uno scopo diverso, 
- non si deve mai iniziare una frase con un numero, 
- il testo deve essere scritto in paragrafi (il paragrafo è una parte di testo che si conclude con il tasto ENTER), 
- l'inizio del paragrafo dovrebbe essere rientrato -> tasto TAB.

La dimensione e il tipo di carattere: 
La dimensione standard per tutto il testo è 12 (per i titoli 14), eccezione fatta per la prima pagina in cui una parte è scritta con il font 14, e una parte con il font 12 (vedi Allegato 2)
Il tipo di carattere (font) dovrebbe essere Times New Roman o Arial. Il carattere scelto deve essere applicato a tutto il testo del lavoro finale. 
Lo stile del carattere (Bold, Italic, Underline) non si applica su tutto il testo, ma solo su determinate parole o parti di frasi che vogliamo evidenziare in modo particolare. Non dovremmo usarlo troppo spesso perché il lavoro risulterà disordinato.
a) Seleziona tutto (Edit --> Select All)
b) La dimensione delle lettere è 12 (Format --> Font --> Size: 12)
c) Carattere (Format --> Font --> Font: (es.) Arial)

L'allineamento di entrambi i lati, interlinea (1.5) 
Il testo deve essere allineato da entrambi i lati (i titoli verranno formati più tardi), e l'interlinea standard per il lavoro finale è di 1,5.
a) Seleziona tutto (Edit --> Select All)
b) Allineare entrambi i lati (Format --> Paragraph --> Alignment: justified)
c) L'interlinea è di 1.5 (Format --> Paragraph --> Line spacing: 1.5 lines)

L'impostazione dei margini standard della pagina
 I margini Standard - su, giù, sinistra e destra sono di 2,54 cm (1 inch). È necessario impostare il margine per la rilegatura a sinistro (circa 1 cm).
File --> Page Setup... --> cartina Margins --> margine (Top, Bottom, Left, Right) metterlo a 2,54 cm, mentre la rilegatura (Gutter) a 1 cm
Immagini, disegni, tabelle e grafici
Le immagini, i disegni, le tabelle ed i grafici si inseriscono tra il testo. 
 Le foto e le tabelle vengono introdotte al centro della pagina e numerate con il titolo sopra la foto. La spiegazione della foto/tabella viene scritta sotto e le foto e le tabelle vengono numerate separatamente. 
Si scrive proprio sotto l'immagine (senza la linea di spazio). 
Sia l'immagine che il nome dell'immagine sono centrati (Format --> Paragraph --> Alignment: Center).


Inserimento dei numeri delle pagine
Le pagine del lavoro finale devono essere adeguatamente numerate. Si inseriscono automaticamente in cima (header) o in basso (footer). La prima pagina non deve essere numerata.
a) Insert --> Page Numbers
b) Possiamo scegliere se i numeri delle pagine saranno in alto o in basso (Position)
c) Sinistra, destra o al centro (Alignment)
d) La prima pagina non viene numerata (lasciare vuoto Show number on first page)

L'intestazione e il piè di pagina 
Nell'intestazione o nel piè di pagina si può inserire un testo che sarà visibile su tutte le pagine del lavoro, per esempio, in cima ad ogni pagina si può scrivere il nome dell'autore e il titolo del lavoro, il tutto sottolineato per dividerlo dal testo principale.
a) View --> Header and Footer
b) Si apriranno le cornici per l'intestazione e il piè di pagina (il resto del testo è di colore grigio)
c) Inseriamo il testo desiderato, lo formattiamo – dimensioni dei caratteri, allineamento, la riga in basso,...
d) Con Close chiudiamo l'intestazione e il piè di pagina e torniamo al testo del lavoro (adesso l'intestazione e il piè di pagina sono di colore grigio)
e) In Print Preview (nei File) possiamo guardare se siamo soddisfatti dell'aspetto del lavoro

Segnatura delle parti del lavoro finale
Il modo di segnare le parti più pratico è il sistema decimale dei numeri. Ogni testa (unità) si indica con i numeri arabi (1, 2, 3, ...). La prima cifra di ogni capitolo coincide con il numero di teste che appartengono al capitolo, e la seconda cifra indica il numero progressivo del capitolo (1.1., 1.2., 1.3., ...). La stessa procedura si esegue per evidenziare i paragrafi (1.4.1., 1.4.2., ...) e punti. 
(Guardare come è evidenziato il lavoro nel Contenuto, Allegato n. 2)
a) Quindi, prima bisogna "camminare" per il testo e aggiungere davanti al titolo i segni di cui sopra. Contemporaneamente prima e dopo il titolo si mette una riga di spazio. Ogni testa (unità) dovrebbe iniziare su una nuova pagina (Insert -> Break -> Page Break). 
b) Vengono quindi assegnati gli stili di titoli: 
I titoli delle unità si formattano in Titolo1 (Heading1), i nomi dei capitoli in Titolo2 (Heading2), i nomi dei paragrafi in Titolo3 (Heading3). 
Contemporaneamente a ogni stile (Heading1, Heading2, Heading3) è possibile aggiungere più di un formato per la formattazione del testo quali: Bold, Italic, Underline. La dimensione dei caratteri per Heading1 deve essere superiore a Heading2, e questa superiore a Heading3 che è maggiore o uguale al testo normale (carattere 12).
c) Selezionare il primo titolo dell'unità, applicarvi Heading1 (Format -> Style -> Heading1 ...), volendo si può aggiungere più di un formato per la formattazione del testo (colori, font size). Dopo di che, nell'elenco degli stili appare Heading1 + ... (ciò che avere aggiunto). Quindi si indicano per ordine i titoli delle unità rimanenti e vi si applica lo stesso stile Heading1 + ...    È pratico perciò usare il Format pointer. 
d) La stessa procedura si ripete per il capitolo (Heading2 +...), per i paragrafi (Heading3 +...), ...
Citazioni e note
Quando citiamo qualche autore, è necessario mettere il testo citato tra virgolette, applicare il corsivo (stile Italic) e specificare chi abbiamo citato. Per questa procedura, è possibile utilizzare i citati. Nei citati possono essere collocate anche definizioni, note, ecc 
Ad esempio: Chinesiterapia (chinesiterapia o chinesiatria) è un sostantivo che deriva dall'unione delle due parole greche “kinésis” (movimento) e “therapeía” (cura o rimedio); significa letteralmente “metodo di cura attraverso il movimento”.1 
a) Insert -> Reference -> Fusnote -> OK, nel testo è apparso a piè di pagina il numero (1)
b) Sulla stessa pagina sotto il testo dopo il segno 1 è necessario scrivere un commento nel modo seguente:
1Chinesioterapia, Branchini Mauro, Milano, 2009, pag. 252.
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LAVORO FINALE DELLA MATERIA: 

Titolo del tema del lavoro finale:








Mentore:	Alunna/o:



Indirizzo di studio:


Rovinj-Rovigno, 202

Anno scolastico 202   /202
INDICE

1. Titolo del capitolo...................3 (font 14)
       1.1. Titolo del sotto capitolo..............4 (font 12)
       1.2. Titolo del sotto capitolo............5	
2. Titolo del capitolo


Foglio delle consultazioni dal/dalle mentore per l'alunno/a: ___________________________
Classe: _______________________________
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	Data della consultazione
	Nota sull'andamento del lavoro finale
	Firma del/della
mentore

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	




Data dell'accettazione da parte del/della mentore e della consegna del lavoro finale:

___________________________________

Firma del/della mentore: ___________________________________

Voto della parte scritta del lavoro finale: ______________________

Data della difesa del lavoro finale: ___________________________

Voto della difesa del lavoro finale: __________________________

Voto finale: _______________________



Commissione:
1. Mentore: ________________________________
2. Professore/Professoressa della materia professionale: ____________________________
3. Professore/Professoressa della materia professionale: _____________________________

Spazio per la valutazione individuale o per eventuali osservazioni:
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